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Crystal reports alternative to subreport

If the keys are not defined in the tables, which allows the radio button to have no effect. For example, if there is a trend that shows a decrease in the sale prices of the resorts, an informative message can indicate this instead of leaving it to the reports reader to deduce. Figure 7.2. Comparison operators Table 7.1: Select expert comparison operators
Comparison operator where the construction of the clause is any value that does not generate a clause where it is. Take a look at how to hide individual field objects, text objects and fields embedded within the text objects, as well as how to hide the complete sections. In Figure 7.26, an alert is edited. DAO is an abbreviation for Microsoft data access
methodology, data access objects. Figure 8.13. Some sections occupy a predetermined and reserved amount of space, regardless of whether they are suppressed, such as the foot, but using this option will minimize the amount of space dedicated to the sections on white. Highlighted in this chapter: Coding a WHERE clause with the selected expert
selected selected selected selected program filtering data according to the user's input with the parameter fields that suppress information with the conditional declarations that highlight the values of Data with the coding of colors and activation of conditional report alerts. The use of the content of this site is expressly subject. To the restrictions
established in the Membership Agreement "CONECLO Â © 2000-2003, FEEDBACKPAGE 4 PAGE 7 - Selectively refine a report using the Mastering Crystal Reports 9 data values of Cate McCoy and Gord Maric Sybex 2003 in a report , the database expert allows you to choose the data tables and the field browser helps you choose the In your report.
These bands are represented in Figure 8.1 as if they were arranged in a piece of paper and in Figure 8.2, since they would appear in the Crystal Design. Figure 7.13. This allows the user to add additional values so that the report is executed, but does not permanently add values values permanent NOTE: If a data source was created using a SQL
declaration that used inequalities in the link field, the default type of link will match the inequality used in the SQL instruction. In non-technical terms, the telephone guide found in most households can be considered a database because all information in you shares a topic; The theme is the name, the direction and the phone number of a person or a
business. SUBREPORT In designer mode in its creation, a sub-report contains several own sections: a header and foot of a report and a discretion section. Capture the preview tab of the subregorte When a sub-report is opened in Crystal, it is displayed on its own tab or on its own web browser window. We can also use the section container to format
a complete section by selecting all the elements it contains so that the overall format can be applied. That is the case here. From this diagram, you should have the feeling that a single application as Crystal Reports can access a variety of different data sources provided that you are registered and managed by the ODBC driver administrator. Regions
Figure 9.13. In this case, there were no coincidence field names between the two tables and there were no keys defined in them. A common technique to ensure that the subrrorport establishes the value before the main report uses the value is to create a new section and place the subinform in that section before section containing the recovery
forming. The grouping of the connection optimizes performance by setting several options. The result set depends on the type of union; There are four types: join internal Ãšnase abroad on the left. Ãšnete to the right. ÃŠnase abroad. Join abroad. Figure 8.11. The input approach of a single screen Use a single-screen approach to request all parameter
entries. The fact that the Standard Report Creation Assistant is used herein besides That a sub-report is not more than a report within a report! Figure 6.28. A sub-report created internally within an existing RPT file can not be seen or access independently of a main report (unless it is saved separately). It is a wild card to match any individual
character, and the asterisk is a wild card character that matches any charger that follows. The previous example is a selection of records based on a text field. Working from from left to right with linked tables, reporting designers choose between internal joints, left external joints, external joints, and complete external joints to achieve the data mix
that respond to your business questions. Delete a comparison value that is all you need to do to get glass to ask users with a value! When the report is opened or updated, you will first see a dialog box asks if you want to use the current parameters values or the request for the new values. The summary melts integrated in Crystal include large total
and grouping resumes with a wide range of operations that can be applied to the data. The order links choose the order in which the links will be processed, from the first to the end. Types of links When a joining is created between the tables using a field, the field value in both tables must match. The result of the coded formula to control a section
must have a value of the real so that the section is affected. Along the top edge of the list of sections there are five action buttons: Insert You can add a new section below the currently selected section. If the sub-report is done before the link field, a connection can not be made because the link field will not have any In the main report until after the
evaluation of the subinform. Variations of data type The options available in the default settings SET depend on the type of value of the parameter. You can also condition conditionally the header of the report and report the foot, as well as add additional sections. Figure 9.6. Sample Data Sample Create a válid link between two fields, the data type of
the two fields must match between SÃ. Like the Hide option (OK OK DOWN), the Delete option in the Expert Section is a duplicate and is connected to the MenÃš option with the same name in the pop-up submenusion for the sections. Group Header Section: Insert a second group header (A and B). At that time, the DLL layer interacts with the data
source layer, recovers the requested data and returns it to the Crystal Reports request. Previously, we discussed using the select expert to create the WHERE clause for a SQL declaration, and we present the following SQL declaration as a way to limit the data in the report to those complexes located in Canada or the United States: Select Resorts.
Resortcode, Resorts.StateProvince, owners.PurchasePrice, Resorts.Country, owners. = "we"), while this is a great approach to refine the data, it totally depends on the fact that the designer report knows what countries include in the report when the report is being built instead of when It is running the report. For example, if a company followed the
information about its inventory and the numbers of used parts â € Registration. The format groups with multiple columns. Columns If the headers and footers of the groups must be associated with the reflected data in the Details section. Advice You can also reposition sections of the same type directly in the design mode with a drag-and-drop
technique. Table C was the third added table using the expert in the database. If the structures of the table between the two databases are identical, the process of converting a crystal report from one data source to another is easy. The type of section (group header, header of pages, details, etc.) is based on the current selected type type. If the
option is disabled, then the field and label print position is governed by the individual printer driver used at the time of the print. ÃŠnase to the left exterior For an example, if the resorts table is left out united with the Financompany table, the result returns all rows of the data resorts table so that they are in the Financompany table. Hide (OK DringDown) is a section property that configured using the section of the section or by clicking on the title of the gray section in design mode and choice of the Hide option (OK DRINGE- Abagrated) in the menu, as shown in Figure 7.21. Resorts Figure 9.11. The essence of the message is that, yes, ODBC access is slower than being in the database directly,
but surely it simplifies the work of reaching the data. Crystal denotes an index in the link dialog box with a geometric shape of five sides (a side dog dog?) That we call an index arrow. Crystal reports can group data on fields, in chemulas and jerhrchically. An alert is listed in the operator's tree, whether enabled or disabled. In general, it is a better
idea to process complexes where the In the environment of the database and return a subset of glass data instead of returning all records and have glass. This is shown in Figure 9.14, with the results of a query that meet the names of the resort with the names of the financial companies when linking A Tourist center field. In this example, the
purchase field is reviewing to see if it is less than $ 200,000; If this is, the alert will be activated. To generate the SQL we have previously, the field to choose from is the field of the country in the Resorts table. The set of three radio buttons for discrete values, range values or discrete and range values, says the glass if the user will choose or by
writing a single value (which is known as a discrete value) or providing a start range and providing a start range A finalization range for the values data. Delete the blank section If a formatted section ends, it does not have data at the run time running the filter criteria, use this option to prevent the entire section from being displayed. To open the
Expert Section, choose that option from the pop-up submenusion that is previously displayed in Figure 8.4 or choose Report> Expert in the section. The articles of the same type of data can be formatted using the option of format objects to open the format editor with the tabs appropriate to the data type represented by the selected objects. To solve
this restriction, use a linked sub-report embedded in a main report in which the sub-report and the main report have separate data sources. In this case, the task is accessing a database to read, update, insert and delete data. A data source can be different tables or different databases or even databases of different types. It will not be and can not
contain headers and foot from page; The concept of a page does not apply to sub-orders. Tip changes made to the selection criteria directly in the formular editor goes into force after the configuration was saved closing the selected expert. Formula Any Válid Crystal Formula that compare a field at a value and A discrete result. Figure 10.3. ODBC
layers If you should ask an illustration of people who have worked with ODBC to give you a single word description, you will hear words as easy, slow, cumbersome, reliable, mandatory, functional, free, and probably probably others. With the encoded condition, it appears in the list of articles on the left. The link dialog box uses the following two
elements to find out if there is a relationship between the tables: the idle coincidence in the name of the field, the primary and strange keys that exist in the tables in themselves, The name of the field that matches if there is a field with an identical name in two tables, Crystal creates a link between the two fields if the data types also match. In this
example, the field has been formatted to be suppressed so that no intermediate values are displayed for this formula, but the value will be available to move to the main report. Cancel menu closes the sub-report menu. Carrier of the alphabet allowed but not required. This will allow the user to decide in execution time that them use. That container, or
area of the section, can be formatted to behave according to the rules that design, forcing all the elements of the report in that section to have the same behavior and visual attributes. When used with the Details section, this option prints / shows the details records at the bottom of the page. The group header # 1 now consists of two components:
group header # 1A and group header # 1B. This can help a loading report and show on a computer screen very quickly, since some of the processes are being postponed until later, if and when the user wants to see the subinform. Actually, many of the many tables to many can not participate in a glass link activity or are a good idea for a database
table due to poor performance problems. Choosing a comparison operator A second drop-down box will appear after choosing the comparison operator. For Figure 7.4, the predetermined behavior of It is to look for a country code equal to CN or US codes. UU and resort that start with letter C. Click on the Select button to navigate the current
computer or any network resources to locate a database. Figure 6.34. Selection of the group in Chapter 6, "Reveal Information," We take a look at To create and manage groups. Table 9.1: Link options button Self-organized table replacements within the white area with link information; You can maximize the screen to provide as much space for
visualization purposes. When choosing that menu option, the check box is enabled and disabling it in the submenusion of the section or in the Expert Section is disabled in both places. Crystal reports can play a key role in addressing this problem. An embedded subprint also of the concept of linked and unrestricted subinportages, a sub-report can be
evaluated, either as a subinform in the place or as a subinform on demand. You can browse the data from the field from the link dialog box, by clicking with the right button in the field and choosing the Browse field, as shown in Figure 9.5. Also visible is an index marker in the Postal Code field. You can provide a list of values so that the user chooses;

This is known as a list of predetermined values in Crystal. To create a new section, click with the right button in the name of the section in the design mode and select Insert> Section below, and then place the subinform in the first section and the recovery formula in the second section . After selecting values for the Purchase Date parameter, it is
very important that you do not click on the OK button. In Figure 7.23, the current field (meaning by the phrase of this field) has been configured to switch to the CAROON source in italics with a double-lined edge if the date is less than or equal at 12:00 A.m. on January 1, 1993. When a set of tables is linked by more than one common field, the order
link button (which is not available is not available in Figure 9.8) allows you to set order in which links must be made first, then, then, second, etc. Total use of Ã centnice abroad. The content on this site is expressly subject to the restrictions established in the Membership Agreement Â © Conello Â © 2000-2003 Ã, "FeedbackPage 22 Chapter 9 - Work
with MÃºLtiples Mastering Crystal Reports 9 of Cate McCoy and Gord Maric Maric 2003 Examples and discussions of multiple tables up to this point have involved two tables, one on the left and another on the right. All Fields of Reports, Formulas, Group Names and Database Fields are accessible through this list. # Digit, space, plus / minus always
permanent but it is not required. When you are working with a single table, this tab is not displayed. To force your group's data to always print on the front, you can combine the following section options that test odd and peer numbers: Page section page: Enable the new page afterwards of the section. In this example, an alert called
SalesPriceBellowaveever has already been created. Practically any database can be treated as an ODBC data source, even if it is not a source of relational data. A simplified list will show only the names of the countries, and if you would like to see what resorts were in that country, it could expand the section to show detailed information. The display
button visible at the bottom of Figure 7.3 opens an edition window where you can directly write a chemula or edit the formular created by the selected expert. In the front, you must connect to your data source to give them some glass data for chomp. This makes a subreport a practical device to incorporate data from different places and present it
within a report. You can think of a DSN as an alias or a nickname that uses an application to request a connection to an ODBC data source instead of using the full name and path of the database. The expert in the section adds the new section and assigns a new alphabetic carrier in ascending order. Once the an-demch option is chosen, no additional
configuration is required to embed the link; However, you can add format that will make The link is a little more pleasant for the eye. In Figure 6.34, you can see that the @GetValue formula has been placed on the foot to show the total number. In the example of the name and Block, if the address2 does not have any value and is in its own line, you
can delete the line with the option to delete the blank lines of the field incorporated in the end of the format editor. This makes the report very adaptable, since the user is in control of the entry used to retrieve the data. This gives the person who uses the report a little initial head in the choice of values válidos. This option is only available when a link
is selected. Figure 10.6. ODBC Connections of experts In the database The list shows all the built-in ODBC connections that were installed with your computer or with later software installations, as well as any DSN that created using the ODBC data source administrator. For example, you may want to print a header information assembly on the front
of a report page, such as the telephone list, and a different header on the back of the page, for example , the list of telephones, continued. To add the first or additional parameters, click on the tab or the new button. To manually add a VALIDO value, type in the select or enter the value to add the box and then use the right arrow button to move the
value to the list of default values. However, once a link is created, the type of link can be changed using the Visible Link Options button in Figure 9.8. There are six types of links, which are mathematically represented on the glass, as shown in Figure 9.9, and that are explained below. This will eliminate all countries from the report that begins with A.
Today, that the data is abundant and propagated throughout the organization. Tracey (Programmer) (OP) October 28 02 16:59 Hii has a report that is based on the records of a company, and contains two subresports.Subreport1 Sample The incidents that have occurred between two ranges of dates for this company, based â € Image on the main
menu and then place the graph behind from the SUBREPORT text link by clicking with the right button To show the contextual menu and selecting Move Back. To the remote right of the Delete check box and on the same horizontal line, there is a chemula button that can click to open the chemula workshop. Use the expert in the database to connect
to the data source from the crystal reports. To modify this default behavior, use parishes around the condition that Execute first. Subrecort on request If a subprint was created on demand when it was inserted the sub-report, this option is automatically enabled. That method is called Dao and described a little later. This means that the link field
appears twice in the resulting data set, once for each table that is it in. A subpair can be created directly within a main report or can be created from an existing separate RPT file, which is then incrupted in a main report. By joining you, you are opting to receive email. Conditional Formulas for Group Headers You can use chemulas to add great
flexibility to sections and your behavior in Crystal. It sounds like a good exchange against fasting any day. In the expert in the database, the order in which the tables adds determines the concept from left to right. Delete Link Remove a specific link that you select. Many reports start out of life by recovering data from a smaller database such as
Microsoft Access and then promoted to the official service in a higher database such as Microsoft SQL Server. Figure 9.16. The three levels in the Crystal data architecture are the Crystal Reports software itself, the translation layer of the database and the storage container layer of the database. This is a new time-saving feature in Crystal Reports 9.
The color is now stored in the primary color box and can search its RGB value. There are quite a few acronyms involved with access to data, and as they appear in many of the dialog windows at Crystal Reports, we have a natural interest in them. This name can be used for programmatic purposes for interactions based on code with the report.
Remove eliminates the sub-report from the main report. Like the fields, the sections can be suppressed conditionally, unconditionally, or at all. The result of an internal union returns all records in the database in both tables where the common field is an accurate match between the two tables. These drop-down tables allow you to choose the table and
the field to use for the list of values available on the left side of the screen; Then, you can add values valued to the list on the right using the arrow buttons between the two lists. Color Spectrum All the color spectrum RGB (red, green, blue) of the world of the computer is available for you. You can codify coding Formula to dynamically establish the
title of the preview tab or hard code, value as the amenities instead of establishing the default name of the subinform. To do this, in the Details section, codify the following form in the Delete option: isnull ({{resorts.fivestarrating}) or {resorts.fivestarrating} = "No" if it is true, the section will not be displayed. This is something useful that you should
do if you simply closed the report alert window more early instead of viewing the records. Figure 10.7. Data source selection We mentioned that Crystal Reports does not provide security for data, but the database in Sã provides security. In contrast, a dBase database is stored as a set of multiple operating system files where each table is stored in an
individual file. Figure 7.26. The headers of the page and the pages can not cover several pages since, by its definition, they are placed at the top and bottom of a page. Caveat. The option maintain together for the sections is not intended to maintain data groups of detail details; For that purpose, use the option keep group together associated directly
with a group. Table 10.2: Data source data source ODBC DESCRIPTION DESCRIPTION The DSN user contains a DSN created for a specific user and usable only by this registered user. Warning If the formula option is chosen, a crystal formula can be encoded instead of the WHERE clause. Text objects and embedded fields The format editor can be
used to suppress text objects, as well as field objects. From here you can do things like changing the predetermined aspect of a subprint on demand to flavor it a bit more from the underlined blue hypervine. New page before using this To place a page pause before printing and display the section. To encode the business rule, a design of databases
creates restrictions on the database tables to avoid duplication of number numbers. The insertion line adds a line to a section while eliminates the last line removes the Line of the section. Most, but not all, there is data stored in databases. The multiple detail sections are used to conditionally control the appearance of the data rows recovered from a
data source. In this subinform, the link is being carried out in the field of the tourist code, which exists in the main report and in the sub-report. In this chapter, we want to deepen the customization options that allow you to control both the appearance and the behavior of the sections and the information contained in a section of section. Highlighted
in this chapter: sections that completely use the drilling sections for groups that create base units using the formulas to control the visibility creation columns within the sections that screen a section to adapt to the data change space options. The use of content on this site is expressly subject to the restrictions established in the "CONECLO Â ©
2000-2003, Â © FeedbackPage 10 Chapter 8 - Customization of Sections Mastering Crystal Reports 9 of Cate McCoy and Gord Maric SYBEX 2003 When you create a report, five section bands are added automatically to your design area as if it were a sheet of 8 1/2 "by 11". To achieve this simplicity, Crystal Reports takes A three-level information
approach to all data sources, which optimizes the recovery model and reports. The use of the content on this site is expressly subject to the restrictions established in the "CONECLO Â © 2000-2003 Membership Agreement Â © FEEDBACKPAGE 21 Chapter 9 - Work with MalTiples Mastering Crystal Reports 9 of Cate McCoy and Gord Maric Sybex
2003 When two tables come together, the process that takes place is that the rows and columns of the first T are recovered ABLA and then recovers the rows and columns of the second table. Internal ÃŠnase left exterior Out to Otters One Law returns all the rows of the table on the left and any row of the table to the right that matches the link field.
The five categories of data sources in the Experts are described in Table 10.1. Tip: You can click with the right button on any of the options in the expert in the database to show a context menu. However, if the name is used, the links have a reasonable possibility of not being created or not being valid for the intention of the data. This option is useful
if you want data to appear below a graph or graph and constantly establish yourself in the same final place on a page. The use of the content on this site is expressly subject to the restrictions established in the "CONECLO Â © 2000-2003 Membership Agreement, FEEDBACKPAGE 13 CHAPTER 8 - SECTIONS CUSTOMIZATION MASTERING CRYSTAL
REPORTS 9 OF CATE MCCOY AND GORC MARIC SYBEX 2003 You thought you may want to print your report in double space mode? The field or the value of the formula is used as a dynamic period of execution time in the subinform to create a Secondary registry selection formula to retrieve data in the sub-report. In this second drop-down box, the
parameter field appears at the top of the list of available values. Read only if the read-only option of the section is Enabled, all section options are disabled. In this formula, you can eliminate the other clause completely or write it as the other of the current part. Sometimes, a table is used simply for soul Dine Information referred to in Bémcas or by
applications. The drilling allows the person to see the report to show the section. The list of values in the SELECT Expert Sort parameter fields at the top since the question mark ordered alphably before letter A. Figure 9.14. Figure 7.8. The parameter fields in the field browser that request the user at any time that uses a parameter field, Making with
the aim of requesting the user to provide information. You can retrieve data, but you can not update or delete it or use Crystal to insert new records into a table. This is useful if you want to switch to a different data source or add additional data sources to the report. To limit the In a report of Vistannations to the countries of Canada and the United
States, the operation is ideal. Numbers fields If the field that is being deleted is a field of numbers, you can apply an additional level of suppression by hiding the number only if the value is zero. The dialog shown in Figure 7.17 can also be used to condition a field conditionally by writing a chemule. Table 10.2 shows what each tab of the ODBC data
source administrator is used. This designer element is used to separate and organize information, promote reuse in data reports and, in some cases, improve the performance of a report. One of the problems with data stored in multiple places is that people who need to connect and recover data are usually not the people who store the data first.
Therefore, the result of the first single is treated as a virtual table in itself and then joins the third table, C. from here, configures an individual data source name (DSN) to represent the database You want to access. The key features of an OLAP approach for data include being able to cut and cut dice information when comparing a parameter to
another in real time with perforation and "what?" Analysis. Sometimes, however, you need to allow direct edition. When a simple summary will not work for you, you can write your own total in total for your most complex and conditional summary. Hide (OK DRINGE-OK) The option to hide with Droduce hide a section until a user double-click to deploy
and reveal details data. Once recovered, the value of the sub-report can be used in the main report in any chemulas that appear after the sub-report. There are several places in Crystal Reports to suppress information. Figure 7.11. With a selected parameter, the of text and the value of the request value change to be specific to the question. Note that
the VistanationsDSN data source that was previously created is in this list. In a one The high level, ODBC can be described as Middleware that is between a data source and an application. See Back to Figure 8.3, where the option is enabled; You can click on the option to disable it and prevent the short names from the section to show in the preview
mode. The use of the content on this site is expressly subject to the restrictions established in the Membership Agreement. CONECLO Â © 2000-2003 Ã, Â © 2000-2003 Ã, Ã ,DackPage 14 Chapter 8 - Customization of Sections Mastering Crystal Reports 9 of Cate McCoy and Gord Maric Sybex 2003 Reas and Sections in a Glass Report It contains and
organizes the fields, labels, images and all the other elements of designer. The visual linking expert has been replaced by the link dialog in the database expert. Figure 9.5. Navigate the field navigation field data allow you to inspect the actual data stored in the table for that column, as shown in Figure 9.6. If the data in two fields in different tables
are the same, then a link can be made. If you were creating this type of chemulas in your report, you may want to use more descriptive names such as SetValueMyCount and GetValueMyCount, creating the name of the variable that is working on the name of the set and obtains chemulas; This would make it easier for keeping the report over time. The
buttons along the right side of the dialog showed in Figure 9.4 will help you verify, validate and correct the links. Figure 10.4 represents the Administrator of the ODBC data source. The SUBREPORT may be a sub-report linked or not introduced, as well as a subinform in place or upon request. Add color to a section The color tab in the Expert Section
allows you to set a background color for a section. Delete field data, complete lines and even sections Another way to refine the information that shows a report. Crystal reports, in contrast, do not provide security. The name of the variable must be identical in the two chemulas. The DSN name is configured to aim to file, for example, c: \ Program Files
\ Common Common Sources \ Vistanations.dsn. These are represented in Figure 10.2. Figure 10.2. The data access architecture as seen in the previous chapters, since a reporting tool and the startup layer, Crystal Reports provides a forward finish to recover data, as well as all the essential elements needed to present, group and summarize it. This
means that you can change the format of the selected field at function of the value of a different field. The language of the structured query (SQL) is used as a language of access to the ODBC data, and although there are many variations in this language, the main commands are somewhat universal. Once a data source is attached to Crystal, data
requests when the report is opened is passed to the translation layer of the database. You can also export the values of a list of default glass values and store it in an external file using the export selection list button. We have no way of doing it with the expert in the database and the field explorer; We need something more. Businessmen, on the other
hand, focus on the intelligence and lot that is needed at the other end of the process to recover and synthesize the data to answer the commercial questions. When working with data related to the group, you can place the sub-report linked in the group header or the group footer, so that each time you change the value of the group field, the subreport changes to show data Specific from the current group of data records. Often, you embed a field or series of fields within a text box. The other very important concept in the creation of a válido link is that the intention of the two fields involved in the link should be the same. Venn's diagrams are used to describe mathematical sets of who are
logical; These diagrams were popular by John Venn in England during the 19th century. Visual linkage tables Crystal reports have a mechanism to help you visualize the tables and see or create relationships between them called the link dialog box, shown in Figure 9.3. When when The tables are selected with the expert in the database, a tab is added
for the links. In this sense, it is a read-only tool. This is shown graphically in Figure 9.21. NOTE: You can add as many conditions to the list of items you need, giving you the ability to configure multiple fields in the same data record according to the same criteria or different. When it is opened, by default it is a user DSN, so you must change the tabs
to create a DSN system. DSNS FILE DSNS file can be used to create connections through systems. You can configure a color directly using the RGB values with glass syntax using the following type of instruction: if todayFieldValue Alerts> Create or modify alerts to open the Create Alerts dialog shown in Figure 7.25. Database designers and
programmers focus on capturing the correct information and creating a storage installation to keep it efficiently. Figure 7.3. A is a selection, you can also write values directly on the value area of the drop-down box and then click on the Add; The Add button is active only when you have written a new value in the drop-down box. WARNING, if the
structures of the table are not identical, changing an ODBC data source can make a glass report unusable. Crystal will not show the value for the field; However, the space assigned for the field will remain visible. You will also want to make sure you place link fields in the main report in sections that precede the Sub-Order. If you can retrieve data
from your data source, you can use the data in Crystal Reports. The use of the content on this site is expressly subject to the restrictions established in the "CONECLO Â © 2000-2003, feedbackpage page, selectively refining a report using the MASTERING CRYSTAL REPORTS data values CATE. And Gord Maric Sybex 2003 When a report is opened,
the person who sees the report takes it as a visual spider, which examines it, absorbs and assimilating information. To build a good report, it is an absolute requirement that you The data relationships behind the report and how can be combined safely and accurately. How would you create a statement that restricted the selection of data to only those
records where the resort was located in Canada or in the United States? Presented in this chapter: Comprehension of the basic database concepts that work with multiple tables that create database schemes that define the commercial rules using the database's expert link dialog box. The content content on this site is expressly subject to the
restrictions established in the Membership Agreement. Conello Â © 2000-2003 Â © FeedbackPage 17 Chapter 9 - Work with Maltiples Mastering Crystal Reports 9 of Cate McCoy and Gord Maric Sybex 2003 Crystal Reports You can recover data from a variety of data sources. The connectivity capabilities integrated in the crystal reports are designed
to be as easy as possible to connect to a wide variety of data storage locations. To set a report option to control whether the section shows during your design work, select File> Options and on the design tab, shown in Figure 8.3 and select the Show hidden sections option. When there is a relationship between the two, Crystal calls this a linked subreport. You can insert multiple subliments into a single main report, and depending on the sections in which the subporats can be displayed once by report, once per page, once per group or once in detail. Have you ever wanted to have a particular part of the general message jumping into the reader? ODBC also offers the advantage of providing an
upgrade route for a report. The SUBREPORT is shown as part of the main report on the preview tab, and by clicking on the SUBREPORT, you can To show the subinform on your own tab. What happens if you decide to use three? three? in a report? Figure 8.17. Figure 8.14 shows the color dialog. A highlighted field note: The highlighted expert can
also be used to format cells in transverse lengtheuts or OLAP grids by configuring the conditions in the header values of the row and the column. In this example, we are going to compare against the field of the country at the resorts table. Figure 7.19. Null values are placed in fields where no coincidence existed. Note. See Chapter 8 "," Quality
Sections, "to obtain more information on how to add additional sections and conditionally delete a section based on a field or formal value. Change the order of the link table can result in a change The data that is returned from the database. In general, it is more easier if the tables are arranged in order from left to right with the links that flow from
left to right also. if it opens and closes more than five databases within a single session of Crystal reports (which means without leaving the crystal reports), the list of databases in the history category will include all. The report would be MÃ It is flexible for the user, and will eventually require less maintenance for the programmer, if the user of the
report could decide and vary that countries will include in execution time instead of having designed time. The remaining sections, however, they are idi nti CAS on behavior and function to your main counterparts of the report. The commercial rules defined by database design specifies these relationships. Take a look at Figure 9.4. No links were
created. By double-clicking on the alert name, simply copy your text name surrounded by double quotes to the edition window. Note: To get more information about the resource shall while they increase, see the 14. Your function is to recover and synthesize the data. When connecting to an ODBC data source in Crystal Reports, you will be asked to
provide a password, as shown in Figure 10.8. That does not mean you have to give one! For example, the Vistanations database does not have the security applied in Microsoft Microsoft So there is no password. Figure 9.9. The types of links are the same values in the two fields involved in the link are identical. Track traces system calls to ODBC for
depuration purposes. Select all the objects in the section each time you are selected more than an object, by clicking with the right button on any of the objects shows a multiple selection submenusion, as shown in Figure 8.18. Tested, true, coder tested. How to get complex section format for working is a matter of thinking about the terminology of
the crystal section What you want it to happen, then tests and combining the individual options to get the results you want. The headers of the page and the pages will appear once per page. The legend of the index identifies the geometric form of five sides to the left of the fields that are indexed. The idea behind a parameterized report is that you can
write a general report, ask the user to provide a value and pass that value in the report in which it is used as a variable in the data request, filtering the data that does not does. T Know the criteria. Put ODBC To work for you at Crystal Reports is a two-step process: Install and configure a data source using the appropriate ODBC controller at the
operating system level. This is the preferred form of making linkage because it is directed directly to commercial relationships intended for tables when the design of the database built them. What is the table on the left? Drivers list all ODBC controllers installed on the computer. On the number tab, select the Delete option. If a sub-reporting title is
not specified, the name of the subinform is used; This is the default value. The postal code field will contain values such as 12508 and 06644, while The Compassdirections field will contain values like North and South. Figure 7.15. This means that if there is no value for the FiveTarrating field or if its value is not, the section is deleted, which prevents
the Detail Data Line from being displayed in the report. When working with linked sub-report, there is to be occasions when there is no data in the sub-report to match the link value of the main report; In this case, the resumes and group totals can appear on the screen as zeros or blank blank. Knowledge of data relationships that tie the tables
between SÃ is essential to create a good report. Manual construction links of construction links are manually manually guaranteeing that the link respects commercial relationships intended by data, since it has knowledge of the meaning of the data. The options available in the Set Default Values dialog box depend on the value type of the parameter.
For example, the reports page feet generally begins to print directly after the last record in the Details section. ON maybe add or remove space between lines as the detail rows are displayed? The goal is not to have to start from the beginning again in a new report. This is the visual track of the design that a section has been hidden. Information at the
foot page is printed on a very small margin at the bottom of each page; This visually puts it below the foot of the information page, which will be printed directly after the last data bits in the Details section. If your report uses more than one type of database, for example, IBM DB2 and Microsoft SQL Server, subinports are recommended as a way to
pull the data in a single report. Its placement in a report controls where the information is displayed and with which frequency. For example, "TRM"> = "RCB" for chain data and 30> = 25 for numerical data. A sub-report containing a common field with the main report can superimpose a link to the report that did not exist in the data source or data
sources. To When there is no relationship between the data in the subinform and the data in the main report, the sub-report is used is not used. When you click on the new button, the Article Editor is also active. There is no option in the expert section to control the line spacing; this this Made in design mode. The point here is that it can have multiple
types of connection in the same database. For example, when you create a name and an address block for a form letter, you can place all fields within a text object so you can format them as a single unit. Múltiples Object Selections WARNING: Format multiple objects, should be the same type of data. Business Question: In addition to the region code,
visualize the description of the region in all reports. Formulas and alerts You can write chemulas in the formular workshop that refer to report alerts to verify if an alert is enabled or a text message is activated or displayed. 9 Dgittens or a space allowed but not required. Crystal Reports provides two features that will help you carry out the data data
data and actually focus your attention on your message: Expert reporting alerts that both differ from each other in which the expert in Highlight uses the color to focus on a user. Attention in records that meet a criterion, while report alerts use text messages in a dialog box to display the data that comply with a coded condition. Note that we are not
going to write any chormule code here; Instead, the highlighted expert dialogue provides drop-down boxes and buttons to automate the process for you. Selecting this option reduces a vertically reduced section, without leaving additional white space between the sections. This can be done absolutely or conditionally using a chemula. Crystal sits out of
the database and extracts the data in the world of reports, as shown in Figure 9.2. Figure 9.2. Pull the basic functionality of the basic database includes the ability to Update, delete and read data rows. Figure 8.12. Note: Crystal Enterprise can be used with Crystal Reports to provide secure access to a web browser report. While it will not be as fast
and efficient as a table join within a data database An index, the sub-report link can provide an alternative to a data situation without problems. Tip: Whenever the link dialog box is used, assume that you need to verify the precision of what you are showing. Since all the connection information is stored in a file, you can store it in a unit that is
accessible by the network by the users of an organization. Configuration of default values For a parameter to present a list based on the values stored in a database column, use the drop-down boxes of the navigation table and navigate in the upper left corner of the dialog. The formula that stores the value is placed in the sub-report; The chemula that
uses the value is placed in the main report. For example, in our example, we have a report that lists the resorts by country. Any of the methods opens the dialog box shown in Figure 7.1. Figure 7.1. The select expert to start, chooses the field that will be used to compare against a value. Figure 10.9. Vistanations ODB connection As mature technology,
ODBC is a powerful data access tool, especially because software products, such as crystal reports, are sent with built-in and ready to go. The option of order links is also available when three or more tables are linked and can be used to control which set of links between the tables are evaluated before them. For example, if the number of the client is
always recovered when it accesses the client's data, an index that orders and administers the number of the client will help recover data from the efficient way. In general, a break will occur at its fixed place, regardless of its data; The rest is based on the line account. For more than two tables, the process of combination of the tables moves from On
the right, pairing as it is processed. Suppress Subreport Blank Even when a sub-report does not contain data, it still occupies placement space in its report. Once saved, the sub-report becomes part of the main report and is stored within the same RPT file. The formation examine would examine See if the field has a value, and if it does not, it would
hide the section or line of details. When the report is previously visible or printed, the information in the heading of the report and the foot of the page will inform each one in the report: at the top of the report and at the end of the report. When you reopen the crystal reports, the five most recently opened you will appear on your history list. A DBMS
may consist of many databases, as well as the security information and system required to manage the data. DSN file All the parameters needed to connect to a data source are stored in a text file with an .dsn extension. These operations can be done with internal tools to the database or with third-party tools. From the field list, choose a field to
compare in the WHERE clause. Security One of the services provided by a full relational database management system is the security of the data. When multiple conditions appear in the list of items, you can sort them in the priority you want to be executed. Figure 8.5 shows a list of resorts by country, and the magnifying glass is visible when the
mouse is on top of the country name. The chemula editor using the drop-down tables in the select expert generates a formula that represents the crystal equivalent of the condition (s) of the clause. The symbol can also be used if the underlying database does not support the symbol! =. The container is stored as a single operating system file or set of
files in a specific proprietary format for the database provider. It can suppress elements in function if a condition is true or unconditionally to suppress it at all times. There is no requirement that the data in a sub-report has any relationship with the data in the major. Use the Comment tab in the Format Editor for all these actions. The section expert
handles a lot of format terms and conditional section options; A combination of changes in design mode and the expert section. Expert Spacing line control submembreter in a report. Drawing it so that it fits it below the [group name 1] item will delete the additional white space visible in Figure 8.15 below the name of the group. People who design
and build a database are generally a different set of people than those who, ultimately, should recover data from it. This will allow to evaluate the link fields and have a value that can be used to connect to the Sub-Order. Figure 10.4. Note from the ODBC data source administrator: If the ODBC driver you want to use is not installed on your computer,
you must first do it using the installation program provided with the controller. The use of the content on this site is expressly subject to the restrictions established in the Membership Agreement. Conello Â © 2000-2003 Ã, Â © 2000-2003 Ã, Â © FeedbackPage 18 Chapter 9 - Work with Maltiples Mastering Crystal Reports 9 of Cate McCoy and Gord
Maric Sybex 2003 When you use Crystal Reports to connect to a database And working with your data, the glass is being used as a data access mechanism in the database. We need the select expert. The name of the subrope should not be changed after it initially configured it, since only the first assigned name will be known or shown within Crystal
on the preview tabs. In the dimplex mode, the page numbers in this situation would have strange page numbers on the front of a paper and even numbers of a page on the back of a paper. Data displayed in multiple columns Note: The format with multiple column option reflects the data in the Details section; Do not do anything to the headers of the
column. When you select it in the section Editor, you can click on a chemula button to condition or disable conditionally to delete and not allow drilling. Once these two are joined, the result of this operation is bound to the final table, D. creating combinations of conditions and comprising how or O O O O O O O ORO, together with them in the select
selected expert You create sufficial reports. Click on the Customize button. The alert function The three language functions of the formula are available in the crystal and basic syntax, and each one as its unique parameter is referenced to the name of the report alert. At the top, it configures the condition criteria, and in the lower part, configures the
visual features that will change when the condition is true. This look at the links between the tables is saying that apparently there is no relationship between the table of regions and the resorts table. It is not equal to value in the first field (the field from) is not equal to value in the second field (field to another). While in reality there is a relationship
between the two tables, the link dialog did not have enough information available to solve it. In many cases, however, one does not exist, and must reverse the investment engineer to identify the commercial relationships integrated in the table design. Table 8.2 describes the three states where a button may be. Format with multiple columns A simple
list of names with phone numbers can occupy many pages if the glass prints only one online record in a report. Object size and positions applying the conditional application options in the expected section, the formula form "N formula form applies to the right of many options of Section. Conditional hiding sections The options to hide and delete
sections using the emerging menu for sections hide in full. The choice of insert> SUBREPORT opens the dialog box in Figure 6.28, and then you can choose to retrieve an existing report by clicking on the Browse or Create an internal sub-report and give it an alias name. Table 7.2: Edit Máscara characters Collection of characters Restriction A
character is required When this option is enabled, if the field finds a value you have had in a previous record, the value will not be printed on the report or displayed on the screen. Deleting sections sections Act as a container for the elements of the report. The beginning, does not start, it is like, and it is not like the options are specific for text data
and, therefore, do not appear as options when the number-rich fields or the date / time fields are being Using in the condition. Delete it completely and not allow drilling. Is not it like the field that is not like 'c? cc * 'here, c is any character, he? This technique is also known as a use of a watermark and can be used to place words such as "only internal
use" and "confidential" behind the contents of a report. There is one more way to hide the sections and which is conditional, which means that if certain conditions are true, the section will not be displayed. There are cases in which it is not possible to pass the WHERE clause to the database, specifically, when glass formulas are used as part of the
WHERE clause. You can hide sections to force a complete container of elements to be hidden at any given time. Figure 9.19. The SQL statements and where the clauses are covered in chapter 11, "use of SQL in Crystal". The use of the content of this site is expressly subject to the restrictions established in the Membership Agreement. Conello Â ©
2000-2003 Ã, "FeedbackPage 20 Chapter 9 - Working with Maltiples Mastering Crystal Reports 9 of Cate McCoy and Gord Maric Sybex 2003 Property Building The links between two tables are not only required knowledge of the data, it also requires Knowledge of what is really happening to the data during the linkage process and what type of result
is desired. Figure 8.9. We can also add new sections in design mode. The new sections are also They can be added with the emerging submenod, shown in Figure 8.4, using the inserting the menu option by continued. The parameter fields are Using in any of the following ways: Select Expert to create a cluster of the fausa del clause to delete the
values or sections that highlight the grouping criteria of expert classification criteria directly in the report to print the selected value of the parameter. parameter. Parameters One of the main purpose of using a parameter field in a report is to ask a question to the user so that the data can be recovered in function of the criteria that you specify. The
expert in highlighting if the report that is in the design will be seen on a color monitor or is printed on a color printer, it could be good to add a color splash to a data value to stand out. Using a Venn diagram, we show the visual representation of a right external union operation in Figure 9.19. The DSN connection parameters are stored in the
registry. Since this is an option that affects the data ranks that are being recovered from a data source, it is available only for the Details section. The use of the content on this site is expressly subject to the restrictions established in the "CONECLO Â © 2000-2003, Â © 2000-2003," FeedbackPage 23 Chapter 9 - Work with Maltiples Mastering
Crystal Reports 9 From Cate McCoy and Gord Maric Sybex 2003 Database Design builds tables that form relationships with other tables through the use of link fields, primary keys and foreign keys. Figure 7.16 shows this second input dialog box. An internal union assumes two tables and a common field between them. It requires 0 dglets. Edit
Masking helps prevent erroneous data when verifying the values for validity values and common sense. In electronic terms, a database is a related information compilation that is stored in a file on a computer. The tables in Sã shares a context and, therefore, are related. An example of a commercial rule in the Vistanations database is that a threecharacter region code corresponds to a textual description of the region. If the selected objects are not all of the same type, it will appear Submenume of multiple selection, but you will not have any option that can be selected, and the format editor is not accessible. Placement of a value recovery form // @ GetValue Ã â, ¬ | Place the formula in the
main report while I impressCords; Numbber shared mycount; MyCount; MyCount; This chemula, the second line of code retrieves the value of the variable of mycount, while the final line of code returns that value to print in the report. Ãšnas to the left data on the right. ÃŠnase on the right. Join right. The only entrance returns all rows of the table on
the right more any row that match the table on the left on the link field function. Once the link is created, a black line appears with an arrow from a field to the other field between the tables. The data browser opens when you choose the database> Start session or deactivate the server from the menu. While the crystal will allow this, the select expert
is not able to generate this code, so you should use the Show Formula button to directly edit the generated code to replace the Y with an O. Indexed fields linking a field in a table that has an index will accelerate data recovery from the database, so if there is an indexed field available, try using it. Figure 7.7. Coding of a group selection formula The
instruction of the condition is all that is needed in the editing box of the formula; You do not need to be a complete statement of IF-later. Chapter 6 - Summarize the Information Mastering Crystal Reports 9 of Cate McCoy and Gord Maric Sybex 2003 A Subport is a report that can be embedded within another report. This dialog sets the report object
relative to the upper left corner of the report. There will be cases when you do not want to do a and but want to codify an or. Figure 7.30. When the user is asked to provide a data value, you may want to specify a multiple value or values. Multiple sections of the same type can help add to flexibility in the visualization of information. The story shows
the five most recently used data sources of the crystal reports. Therefore, understand relational terms, such as tables, rows and columns, is useful for crystal design, even if the data that are recovered come from a file data source of text. The particular sub-report that is shown here includes a group. group. A chemula Favorites hold a manually
maintained list of common use data sources; You can drag and drop sources from the expert in the database to add them to the Favorites folder. Once a value is provided for the Purchase Date parameter, the user selects the Pais parameter in the list. A typical chemula used to set a background color for a section is one to toggle the shading of the line
in the details section to facilitate reading of rows and rows of data. Figure 7.3 shows the inclusion of CN and EE. UU for Canada and the United States, respectively. Use the option to keep together to force the crystal reports to keep all the content of a section on the same page. The second table, Table B, was added continued. For a person who looks
at a report that contains a subinforcement in place, the sub-report may seem that it is inside a rectangle in blackboard. For example, if you click on a great total, you can deepen and see the detailed data that contributed to the great total. Likewise, the deactivation of it in the submenusion of the section or in the Expert Section is disabled in both
places. As with the arrow button upwards, the order of the original five sections placed in a Crystal report is static and can not be changed. The custom sections options allow both the design of reports and the user of the report to choose to hide or display information conditionally or completely. In some cases, your knowledge of the language of the
formulas will be required; In others, you only need to enable a check box. It is rare that a database does not come with an ODBC mechanism to use it. In the example of the aforementioned client, in a table of all customers, each client would be represented as a data row; If there were five There would be five records in the table, one for each client.
Crystal reports can report data from almost any data source, either a text file or a complex database. You can eliminate only the sections you have added. In this case it is That free-form placement is enabled. Let's see and group this data, we use chemulas to manipulate the fields to create new values, and used the crystal repository in our reports. The
idea is to let the user choose a value for the country in an ad hoc way and on the fly. Wait, that does not mean there is no relationship! All it means is that the link dialog box could not help build the links. If there is a database scheme for your database, you are really leading an enchanted life. When you connect a subinform to a main report, choose a
field of database or a formula to use as a connection value. Figure 8.3. Configuration of the Design The use of the content on this site is expressly subject to the restrictions established in the "CONECLO Â © 2000-2003" Factory Agreement - Customer Sections Customer Reports 9 of Cate McCoy and Gord Maric SYBEX 2003 To the left of the design
design of a section is the name or abbreviation of the section. For the date of purchase, a date range is required and drop-down boxes are provided for the start and end date of time values. Why? Take a second look at Figure 10.3 and you will notice that it is slow (ER) due to the two layers between the application (Crystal Reports) and the data
source. In Figure 7.4, we see that the field of the tourist code has been established to allow only resort codes that begin with letter C. Figure 7.18. When a design based database creates the scheme, we are defining the relationships between the tables, as well as the commercial rules. To create a manual link, use a drag-and-drop technique: Click on
the field you want to link and arrest it to the field you want to link. Figure 7.5. Selection of SQL query record generated the expert Generates a selection of records that can be edited directly without using the selected expert dialog box. Optionally, you can use the check box to the right to include the value in the range; Not checking checking The box
excludes the value of the range. Subparts do not enter directly from the design mode by clicking on the icon in the Update or Choose Toolbar> Other views and choose the Sub-Order to show. The placement of a sub-reporting element in a report is immediately evaluated from left to right and from top to bottom, and as a sub-report is an element, it
will be evaluated and will be displayed after any fields that come before Ã © l and before any element that follows it. If you create an internal sub-report with an alias name, by clicking on the Report Wizard button (shown in Gray in Figure 6.28) opens the Standard Report Creation Wizard to help you choose a data source and fields and perform
selection of groupings and record. Figure 9.3. Expert in the database: data tab that can be seen in Figure 9.3 that two tables have been selected for use in this report, the Resorts Table and the Table of Regions. This causes the value of the parameter to be part of the WHERE clause to consult the database. \ (Backslash) escape car used to allow A, A,
0, 9, #, L,? &, C in the text that the user is writing; E.G., write the value as \ A to allow one A in the data. The select expert has a separate tab for each condition in the WHERE clause. ÃŠnase to the rates join the internal revenues are made by default in the expert link dialog box in the database. As you drag from the start field, the mouse pointer will
change to a circle with a line through it when it is through a place where you can not link and change to an access arrow Direct, shown in Figure 9.7, when it is through a valid delivery point. The eye is visible but not open in Figure 6.28. // @ Sedevalue "| Place Formula in while remembering the records; Numbber shared mycount; If
{resorts.fivestarrating} = True, then MyCount: = MyCount + 1; With this field in the Subinformador (which has been positioned in the Detail Section), the field to recover the value can be placed anywhere in the report below the Sub-Order. Both show a one Approach of current connections, repository, favorites, history and create new connection
options. You can think of a section as a container for the fields, images and tags located in the section during the reporting. This option is not available if the SUBREPORT that is formatted is not using the opening style to request. It's like where the field like 'c? cc * 'here, c is any character, he? Choose a comparison field after choosing a field, you
must choose the comparison operation. As you can guess, this can cause some undesirable results when you attach text labels or field values within graphic elements, such as boxes. The contents of the two sections are preserved and merged. To do this, we must advance more from the expert in the database and the field browser and investigate the
additional mechanisms integrated into the crystal reports to build more complex recoveries and filters. Below the message box there is a check box to enable or disable the alert. Enable the footplace page footproof option can minimize the amount of space reserved for a pages using the highest page height. If you request new values, a dialogue
similar to that shown in Figure 7.15 is displayed. We are going to look at the new option, suppressing the blank lines of embedded field. This allows individual values to be added or a range of values as answers to the parameter indicator. New page after using this option to place a page break after printing and displaying a section. You can enable or
disable change from demand to reports within the place and vice versa. Table A was the first added table in the expert in the database. The names of the parameter fields are displayed A sign of question as the first character and then what you named the field. Using a Venn diagram, we show the visual representation of a complete outer union
operation in Figure 9.20. Note that all the ranks were returned even if there is no financial company because there was an exact coincidence in the The nulls are placed in the Financompany field. At this point, it can no longer configure the header of group # 1, since it is just a title that contains the other two; They are the two subcomponents that can
be configured. As someone who works with the data, a designer of reports would explore the data, find out that it was the same, and declared that the two fields must be linked regardless of the difference in the names. SQL Viewing When a database is used with SQL capacity as the data source, you can check the selection clause and the onegenerated WHERE clause generated by selecting the database> Show SQL quens. In Microsoft Windows Systems, this is done using the ODBC data source administrator, shown in Figure 10.4. In Windows 2000, you will find this from the Control Panel> Administrative Tools> Data sources (ODBC). Using a Venn diagram, we show the visual
representation of the left external union operation in Figure 9.17. Like each new group to start with a new page, but you also want the new page to always be the front of a piece of paper. About Determine Qué version of ODBC is in use. Table 7.3 describes the functions. When it was created, the country's field used the discrete value and the value of
the range (refers to Figure 7.9). To the right, ÃŠnase to the outside, Ã¼ase to a complete external urgency, returns all the rows of the table to the left and all rows of the table on the right. When the option is enabled, an additional tab appears in the Expert Section to specify the size of the columns and the amount of space to exit between the
columns. The list of functions incorporated into the print status area of the formular workshop will be very useful for you in the conditional format sections. The image on the screen of your computer, block it on the clipboard with Ctrl + C, PÃ © guel in Microsoft Paint using Ctrl + V, and then use the eye dropper tool to select a color image. If the
database keys are used, the links will be accurate and the design will follow. Design. of the scheme of the database. Figure 7.18 shows this option. Well? For example, in a database that tracks the client's information, a commercial rule would define how many telephone number will be traced for each client and if it would be allowed to add a client if
its telephone number is not known . In the translation layer of the database, Crystal Reports uses a series of dynamic link libraries (DLL) that send and install the product to provide access to practically any database. Figure 7.29 shows a data set that generated a true condition for the alert shown in Figure 7.28. Edition of a subinform when editing
the subinform, the design of the design elements is shown in its own tab, as shown in Figure 6.32. The RMBMS TÃ © rhine also is common, where the R represents the relational relationship. The formula that establishes the value should appear in the report before the formula that recovers the value. If this option is not enabled, Crystal adds the
combined sizes of all page and reserves that amount of space at the bottom of each page, regardless of whether the feet of page HAVE It was suppressed or not. WARNING, because the evaluation time of a subprint on demand is determined by the user of the report, the variables can not be shared between the sub-orders on request and the main
reports. To activate the alert, the condition must be true. Finally, Table D was the last added table using the expert in the database. If you were to execute the report, again you will see the original numbers. The process involves reading information about the report and discovering when it is your main message. This is not a surprise. There is no way
to build a good report if there are incorrectly linked fields. The use of the content in this It is expressly subject to the restrictions established in the Membership Agreement "Conello Â © 2000-2003 Ã, Â © 2000-2003 Ã, Â © FeedbackPage 6 Chapter 7 - Selectively refer a report using the Mastering Crystal Reports 9 data values Cate McCoy and Gord
Maric Maric 2003 Another way in which you can filter, control or refine what the user sees a report is to delete (meaning to hide) data and text objects. The dialog shown in Figure 7.28 Redisplays and gives you the possibility to see once again the records that meet the alert criteria. When the clause is true, the group is included in the report, and
when it is false, the group is excluded. WARNING, the ÚCONO of the toolbar used to identify the expert in the database in this version of Crystal Reports was previously used to enable the visual linking expert. The difference between the two is that the person who sees the report can show an execution time section using the first option, while with
the second option, the user never sees the section. Safety should be applied at the database level or at the operating system level. If a field is of type / hour type, the default time component at 12:00 A.m. and will be automatically included in the glass threshold value. The commercial rule in effect in this situation is that a region may contain many
resorts. This part of the screen is organized in two parts. A DLL is a program used by other programs to perform a specific task. The threshold value drop-down box is automatically filled with sample data from the database for the value of the chosen field. Note: You can delete a value from the list after adding it by selecting it and by clicking on the
Remove key on the keyboard or using the Delete button to the left of the list of values. If the link dialog box noticed a relationship between any fields, you would see a line from the field on a table to a field in the other table. Tables that do not have an index can benefit from being embedded in a subinforce linked because, in general, the tables do not
They can not be joined with any other table. The modification and creation of an alert are performed from the same dialog box, and new buttons, edit and delete guide you in the task you want to do. In addition to suppressing the As the previous formula does, you can add conditionally blank lines according to the field values, conditionally add boxes
and graphics based â €
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